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MOODLE TEXTBOOK 

CUSTOMIZING DASHBOARD 
About the Dashboard 

The Dashboard is a customisable page for providing users with details of their progress and upcoming 
deadlines. In the centre is the Course overview block which allows students and teachers to easily track 
required activities and filter courses. 

Watch Video: https://youtu.be/VApmuVO7sHY 

 

OVERVIEW OF THE DASHBOARD 
If course images have been added in the course settings, they will display in the dashboard. Where no 
images have been added, coloured patterns appear. (New in 3.8: The administrator can define the 
colours from Site administration / Appearance /Course pattern colours.) 

Quick access to Dashboard is also available from the user menu top right of the screen once logged in: 

 

 

The Navigation drawer or block includes a Dashboard link directly above or below the Site home link. 
Once a regular user is logged in, the My courses link will also take them to their Dashboard. 

https://youtu.be/VApmuVO7sHY


Users can normally customise their Dashboard, adding or removing blocks and changing block 
positions. They can revert their Dashboard back to the original blocks as follows: 

1. Click the 'Customise this page' button. 

2. Click the 'Reset page to default' button. 

 

 

USER MENU 
The user menu can be accessed by clicking on the small triangle next to your user name at the top right 
of the Dashboard, the home page, or most other pages in your Moodle site. 

 

When you click on the small triangle next to your user name, a dropdown menu will show links to your 
dashboard, profile, grades, messages and your preferences. There will also be a link to log out of the 
site, and (if you are a teacher or admin) there may be a link that allows you to Switch your role. 



 

 

ADDING A BLOCK TO A PAGE 
Blocks can be added to a page by turning editing on then using the 'Add a block' drop-down menu. 

Please see Blocks for a list of all the blocks in a standard Moodle install. Your site may have added 
contributed blocks and or your site administrator has disabled specific blocks on your site. 

Block actions 

After adding a block, click the edit icon in the block header to configure it. 

 

CREATING A NEW EMPTY COURSE 
-Log in with your administrator account 

-From the left panel (the Navigation drawer) click the icon on the left at the bottom 

-Add your course details, using the icon helpicon (?) for extra help 

-Click Save and display 

-Click Proceed to course content to add your teaching materials. 

Watch Video: https://youtu.be/Gl1YAIDu_mc 

Course full name: 
This is the name of the course. It is displayed as a link on course lists on the Front page and on the 
Dashboard and in reports. It is also used in the browser title bar when the course is viewed. 

 

https://youtu.be/Gl1YAIDu_mc


Short name: 
Many institutions have a shorthand way of referring to a course, such as BP102 or COMMS. Even if you 
do not already have such a name for your course, make one up here. It will be used in several places 
where the long name is not appropriate, such as the Navigation block. 

By default, only course full names are displayed in the list of courses. However an administrator can 
enable short names to be displayed too if required by ticking the checkbox in Administration > Site 
administration > Appearance > Courses. 

Course category: 
The site administrator may have created course categories to help teachers and students find their 
courses easily. Course categories may be reflected in the Navigation block. 

 

Course start date: 
This setting affects the display of logs and the weekly format topic dates. 

If you use the "Weekly" course format, the start date will appear in the first section of the course. For 
example selecting 27 July, will display "27 July - 2 August" in the first section (when default display is 
selected for that section). 

This setting will have an effect on the display of logs. This will be the earliest possible date the log 
activity will display. 

This setting will not affect courses using the 'social' or 'topics' formats. 

TIP: In general, if your course does not have a real starting date then set the date to yesterday and use 
the availability setting to reveal the course to students. 

TIP: See self enrolment course settings to prevent students from entering the course before a certain 
date/time. 

Course end date: 
The course end date is used for determining whether a course should be included in a user's list of 
courses. When the end date is past, the course is no longer listed in the navigation block / drawer and is 
listed as past in the Course overview on students' dashboards. 

The course end date is also used for calculating the retention period before data is deleted. It may also 
be used by a custom report e.g. reporting activity for the duration of a course. 

Users can still enter the course after the end date; in other words the date does not restrict access. 

Calculate the end date from the number of sections 

For courses in weekly format only, the course end date may be calculated automatically based on the 
course start date and the number of sections. If course sections (weeks) are added or removed, the 
course date is changed automatically. If 'Calculate the end date from the number of sections' is ticked, 
the course end date can not be set manually. 

 



Course visibility 
Here you can "hide" your course completely. It will not appear in the list of courses, except for 
managers, course creators, teachers and any other users with the view hidden courses capability. Even if 
students try to access the course URL directly, they will not be allowed to enter. 

Course ID number 
The ID number is an alphanumeric field. It has several potential uses. Generally, it is not displayed to 
students. However, it can be used to match this course against an external system's ID, as your course 
catalogue ID or can be used in the certificate module as a printed field. 

 

 

Description 

 

 

Course summary: 
The summary appears on the course listings page. This field is searched when searching for a course and 
also appears in the Course/Site description block. 

 

Course image: 
An image (and if allowed by the administrator, other file types) may be attached to the course summary. 
They will be accessible by anyone from outside of the course just like the course name and/or summary. 



Only users with moodle/course:changesummary capability are able to upload/change course summary 
files. Note that if this is not allowed by the administrator, then no box will appear to upload course 
summary files. 

By default, only jpg, gif and png file types are allowed as course summary files. An administrator can 
change the allowed file types in Administration > Site administration > Appearance > Courses. 

Course format: 
Weekly Format 

The course is organized week by week, with each section having a date heading. Moodle will create a 
section for each week of your course. You can add content, forums, quizzes, and so on in the section for 
each week. The current week is highlighted. 

TIP: If you want all your students to work on the same materials at the same time, this would be a good 
format to choose. 

NOTE: Make sure your course start date is correct. If it is not your weeks will have the wrong date on it. 
This is especially important if you are restoring a course to use with a new section of students. 

If you have students starting the course at different times, you can use the feature Course relative dates 
to display dates for each course section relative to the student's start date in the course. Example: 

 

The course is organised into topic sections that a teacher can give titles to. Each topic section consists of 
activities, resources and labels. In new installations of Moodle, this is the default format. 

TIP: This is great to use if your course is objective based and each objective may take different amounts 
of time to complete. An example of this would be scaffolding where the students are building upon the 
knowledge from earlier topics. 

 

"Show only one section" 



With the Weekly, Topics and any contributed format that implements the functionalty, it is possible via 
Administration > Course administration > Edit settings to "show one section per page". Here is a course 
with eight topics, with the third one currently shown. The links left and right lead to topics two and four: 

 

 

Notes: 

The course home page shows just the section names and any text in the section description along with 
activity and resource numbers, with the names being click-able. This is what you see the first time you 
access the course. Once you have selected a topic by clicking on its name, you then see one section at a 
time. 

If editing is ON, then the Main course page will display all the content in all the sections. 

There is a 'Jump to...' menu at the bottom of each single section page. 

 



 

When selecting the social format, it is possible to specify how many discussions you wish to display on 
the course page: 

 

The social forum can be edited by clicking the 'Update this forum' button on the social forum page. The 
forum introduction is displayed at the top of the course page. Activities and resources can be added on 
the side by using the Social activities block. 

Single activity format 

The single activity format only has 1 section, and allows the teacher to add one activity only to the 
course. When the single activity format is selected, a drop down menu appears for the teacher to 
choose the activity they wish to use. See the "See also" section below for a screencast and working 
example of the single activity course format. 

 



Note: This course format replaces the SCORM format in earlier versions of Moodle, as it is possible here 
to select a SCORM package as the single activity. 

Single activity format with a forum as the activity and social format are very similar. The only difference 
is when the course contains other activities. The single activity format displays them as "orphaned" and 
for teachers only; the social format displays them in an activities block and available for students. 

Grid format 

The Grid course format is a modular and visual course format. Hides all topics and creates a grid of icons 
(one for each topic) with short titles. Clicking on an icon brings up the content from the corresponding 
topic in a "lightbox" style display. 

Hidden sections: 

This option allows you to decide how the hidden sections in your course are displayed to students. By 
default, a small area is shown (in collapsed form, usually grey) to indicate where the hidden section is, 
though they still cannot actually see the hidden activities and texts. This is particularly useful in the 
Weekly format, so that non-class weeks are clear, or if you have quizzes you don't want your students to 
see. 

TIP: If you choose, these non-available items can be completely hidden, so that students do not even 
know that sections or an activity in the course are hidden. 

Course layout: 
The Course layout setting determines whether the whole course is displayed on one page or split over 
several pages. The setting currently applies to the topics and weekly core course formats and 
contributed collapsed topics course format only. 

Teachers choose from the dropdown whether they wish to "show all sections on one page" in the 
familiar scrolling format, or "show one section per page". 

If one section per page is selected, the course page is abbreviated to a list of links to individual sections. 
If an individual section is shown, next and previous sections may be accessed via links above and below 
the section. 

Appearance: 

(These settings are collapsed by default.) 

 

 



Number of announcements: 

How many recent announcements from the Announcements forum should show in the Latest 
announcements block. 

If an announcements forum is not required in the course, this setting should be set to zero. 

Show gradebook to students 
Here you can decide whether to allow students to see the link to grades in the Administration block. If 
your course doesn't use graded activities, it makes sense to disable this. If grades are used and this link 
is disabled, students can still see their grade from the actual activity itself, such as an assignment 

Show activity reports 
Here you can decide whether to show students their activity reports. Doing so places a load on the 
server however, which is why the setting is disabled by default. 

Files and uploads 
(These settings are collapsed by default.) 

Maximum upload size 
Here you can decide the largest size of file that students can upload to a course. The site administrator 
can determine sizes available for the teacher to select. 

Completion tracking 
(These settings are collapsed by default.) 

Completion tracking must be enabled for Activity completion. Course completion criteria may also be 
based upon Activity completion values found in the activity's settings. 

Groups 
(These settings are collapsed by default.) 

 

 

Group mode 

Here you can define the group mode at the course level by a pull down menu. "No groups", "Separate 
groups" and "Visible groups" are the choices. The selected setting will be the default group mode for all 
activities defined within that course. The group setting can affect what users see in the participants list 
and who they can interact with in activities. 



Force 

If the group mode is "forced" at a course-level, then this particular group mode will be applied to every 
activity in that course. This will override any activities that may have a special group setting. 

Default grouping 

If groupings are enabled, a default grouping for course activities and resources may be set. 

Role renaming 

(These settings are collapsed by default.) 

 

You can rename the roles used in your course. For example, you may wish to rename the Teacher role as 
"Facilitator", "Tutor" or "Guide". These new role names will appear within the course. For example on 
the participants and the override permissions pages. 

Please note that the site administrator may have changed the names or added new roles. These names 
will appear and the teacher may rename them. 

Tags 
Teachers can add course tags here, either new tags or official tags. See Using tags for more information. 

Save and display to proceed. 

 

 

 

 

 

 



TO EDIT A COURSE SECTION 
-Turn editing on found on the top right  

-Click the pencil icon (1 in screenshot below) to quickly rename the section 

-Click the Edit menu (2 in screenshot below) to edit the description and other settings.

 

To move a course section 
-Ensure turn editing is on 

-Click the up/down arrow or the crosshairs icon to move the section 

-Drag the section to where you want to position it and let go 

 

To add course sections 
-Ensure turn editing is on 

-Click 'Add topics/weeks' underneath the bottom section 

-Select the number of extra sections you wish and press 'Add topics/weeks': 

 

To delete a course section 
With the editing turned on, click the 'Edit' link to the right of the course section you wish to delete and 
then, from the menu that displays, click 'X Delete'. You will be prompted to confirm your wish to delete 
the section and its contents. Note that all activities inside the section and their user data will also be 
deleted. Use the Recycle bin to reverse this if you do it by mistake. 

 



Activities and resources 
-To add an activity or resource to the course 

-Turn on the editing from the button top right. 

-Click 'Add an activity or resource' to open the activity chooser. Double-click to add an activity or 
resource; click the ‘I’ for more information and click the star icon to add it to a separate, starred tab. 

If desired, the activity chooser may be disabled from Course preferences from the Preferences link in the 
user menu. This will then display two separate resource and activity dropdown menus. 

 

 

Alternatively, certain resources and activities may be added using drag and drop: 

-To add a file, simply drag and drop it onto the course section where you'd like it to appear. 

-To add a folder of files, simply zip the folder then drag and drop it onto the course section where you'd 
like it to appear, answer 'Unzip files and create folder' to the popup dialogue, then click the upload 
button. 



-To add a SCORM package, simply drag and drop it onto the course section where you'd like it to appear, 
answer 'Add a SCORM package' to the popup dialogue, then click the upload button. 

 

Watch Video:  https://youtu.be/MRX3NOO_oNY 

 

Activity navigation 
Underneath each activity is a link on the left to the previous activity and on the right to the next activity. 
A jump-to menu also allows you to choose other activities from the course page: 

 

 

Editing elements on your course homepage 
With the editing turned on, activities, resources and blocks will have icons performing different 
functions such as edit/move/copy/delete/hide. 

 

 

 - the pencil icon allows you to edit inline the title of the resource / activity 

https://youtu.be/MRX3NOO_oNY


- this icon groups actions together for easier editing on smaller screens. Click to 
reveal the options. 

- the move icon allows you to move items or sections by dragging and dropping. (If you have 
many activities to scroll through while moving, see the Tips and Tricks section below for a useful 
suggestion.) 

- this move icon appears if you don't have Ajax enabled. 

- the groups icon allows you to change between no groups or separate/visible groups 

- the move here icon appears when moving a course element 
without Ajax. Click into the box to re-locate your item. 

- the up/down arrows allow you to move course sections up or down and appear if you do 
not have Ajax enabled. 

Tips and tricks 

Moving items in a course with many activities 



If you click and drag an activity or resource on a course page which has many items, this might cause you 
difficulties with "scroll of death" issues. Instead of dragging the activity to move it, click on it. It will 
display a list of all the items on your page and you just need to click to select where on the course page 
you want the item to be moved to. 

 

 

LESSON ACTIVITY- LESSON SETTINGS 
This page explores in more detail the settings for the Lesson activity once you have added it to your 
course and also covers the Site administration settings. 

Appearance 
Progress bar 

 Choose this to show a bar at the bottom of the page showing how far into the lesson the student has 
got. 

For lessons containing only  Content pages, once a lesson has been taken to the end, if that same lesson 
is re-taken, the progress bar will not be "reset", i.e. it will show a 100% progress from page 1! 



For lessons containing Question pages and set to "Re-take" Yes, the progress bar is always "reset" at 0% 
upon re-take. 

Note that the Lesson Progress bar only works correctly for lessons with a "straightforward" navigation, 
such as page 1 -> page 2 -> page n -> end of lesson. It is not guaranteed to work with pages "jumping all 
over the place". 

Display menu 

Choose this when you want to show a list of the content page titles in the Lesson to the student. Only 
those pages which have "Display in menu?" checked will display. The menu will not display question 
pages. 

Depending on what the administrator has specified as 'Advanced', other settings will be displayed by 
clicking a 'Show more' link: 

 

Linked media 

If you want to include a link to a media file for students to refer to, upload it here. A 'Click here to view' 
link will be displayed in a block called 'Linked media' on each page of the lesson. 

The width and height of the pop-up window may be set by an admin in Site administration > Plugins > 
Activity modules > Lesson. 

Display ongoing score 

Choose this to let students see their score as they work through the lesson. It won't display for teachers 
previewing the activity. 

Minimum grade to display menu 

Choose this if you want the student to go through the lesson once and get a grade before they can (on 
review) see and navigate through all the different pages. 

Slideshow 

Slideshow height, width and background colour are set for the whole site by an administrator in Site 
administration > Plugins > Activity modules > Lesson. 

Maximum Number of Answers 

Here you can set the default number of selection boxes available when you add or edit a question or 
content page. For instance, if you are only going to use multiple choice questions with 3 answers in your 
lesson, you might select 3. You can change the default here at any time to display more or less question 
answers or content choices. 

Note: This only impacts the editing screen. Changing from 4 to 2 will not remove or hide any answers 
previously entered from the student. 

Use default feedback 



Every Moodle site has a standard response (feedback) when a student selects a correct or wrong answer 
in a lesson. Select "No" if you only what you put as a response for a specific question's answer to display. 
In this case, when you leave the response to a question blank, the student will not see any comment 
about their answer. The typical Moodle standard responses are: "That's the correct answer" or "That's 
the wrong answer". 

Link to next activity 

Choose this to give students a link to another activity when they reach the end of the lesson. 

AVAILABILITY 
As well as selecting here a start and end date and time for your lesson, you can set a time limit and/or 
password. 

Allow lesson to be attempted offline 

Enable this setting if you want students to do the activity on the Moodle app. It will be be downloaded, 
done offline and then resynched. by a mobile app user. Note: You cannot use this setting if you have set 
a time limit on your Lesson. 

FLOW CONTROL 
Allow Student Review 

This puts a "Review Lesson" button on the last screen of the lesson to encourage the students to 
navigate through the lesson again. If the lesson contains questions then the review will start from the 
first question, otherwise the review will start from the first content page. 

Note that the students will not be able to change their answers, only view them. 

Provide option to try a question again 

This displays a button after an incorrectly answered question so that the student can try again (but not 
get credit for it). If the student clicks to move on to another question then the selected (wrong) answer 
jump will be followed. By default wrong answer jumps are set to "this page", so it is recommended that 
you set the wrong answer jump to a different page to avoid confusion with your students. 

TIP: Leave this off if you are using essay questions.  

Maximum Number of Attempts 

Decide here how many times you want students to be able to attempt each question. When they reach 
the maximum, they will be taken automatically to the next page. 

Note: this setting works in combination with the above setting, or independently. 

 

When 'provide an option to try again' is set to No, students will be able to retake the question as many 
times as it is set here, with a score penalty. 

When 'provide an option to try again' is set to Yes, then students will be able to retake the question as 
many times as it set here without a score penalty. In this case an extra dialogue appears. 



Consequently when the relevant jump 'this page' is used in wrong answer while the 'provide an option 
to try again' is set to No and 'maximum number of attempts' is set to 1, a student that will answer 
wrongly will be moved into the next page, since he/she has the change to try the question just once. 

Ensure you check lesson using a real student account, as the teacher preview or the 'switch role to 
student' may not give you the exact picture. 

Depending on the what the administrator has specified as 'Advanced', other settings will be displayed by 
clicking a 'Show more' link: 

 

Action after a Correct Answer 

Choose here where you want a student to be sent to if they get a question right. See Using Lesson for 
more details on this setting. The options are: 

-the next part of the Lesson (default setting) 

-a random, unexpected page 

-a random page which they have not yet answered. 

Number of pages to show 

You only need this if you have set "Action after a correct answer" to show an unseen or unanswered 
page. Otherwise, all pages will be seen 

GRADE 
Set a grade and grade category here, along with a "Grade to pass" which may be connected with Activity 
completion and Restrict access such that a student will not be able to access a follow up activity until 
they have obtained the required grade in the lesson. 

Practice lesson 

Practice lessons are now saved; this means they will appear in the reports .You must enable the 
"Retakes allowed" setting if you want students to be able to attempt a practice lesson several times. 

Note: If you are upgrading from an earlier version, be aware that all practice lessons will have " Re-takes 
allowed" set to "Yes" . If you are restoring a practice lesson made before this change, you may need to 
modify the "Re-takes allowed" setting if needed. 

Custom Scoring 

Use this to give a particular number score (negative or positive) to each answer 

Re-takes allowed 

Choose this if you want your students to be able to do the lesson more than once. 

Note that this setting only applies to lessons containing Question pages. Lessons consisting only of 
Content pages can be re-taken even if 'Re-takes allowed' is set to No. 



 

Depending on the what the administrator has specified as 'Advanced', other settings will be displayed by 
clicking a 'Show more' link: 

 

Handling of re-takes 

If you allow your students to re-take the lesson, then decide here if the grade for all lesson attempts is 
the mean or the maximum. 

Note that the Question Analysis always uses the answers from the first tries of the lesson. Re-takes by 
students are ignored. 

Minimum Number of Questions 

Set the minimum number of questions that will be used to calculate a student's score. Students will be 
told how many they have answered and how many more they need to answer. 

If you are using Content pages, then set this to 0. 

If you use this setting, then add some explanatory text at the start of the lesson so the student knows 
the minimum number of questions they must answer to receive a grade. 

OTHER SETTINGS 
Depending on what is enabled for your site and course, you may also need to explore Common module 
settings, Restrict access and Activity completion 

If your Lesson activity doesn't display as you wish, check the site settings below: 

USER AND GROUP OVERRIDES 
When a lesson has been created, it is possible to overrride certain settings for individuals and groups 
from Lesson administration. In situations where two group overrides may apply to a single user, the 
most lenient date is used. For "Available from" dates, this means the earliest possible date is used, for 
"Deadline" dates, this means that the latest possible date is used. Note also that if there exists a user 
override for a student, it will always take precedence over any group overrides. 

It is possible to override passwords, availability/deadline, time limits and question retries and lesson 
retakes. 

Selecting one of the options, for example 'User' will display a button to click. From the next screen you 
can choose the user or group to override and the settings you wish to override: 

 

 

 

 



 

WHAT IS THE LESSON ACTIVITY? 
The Lesson activity allows teachers to create 'branching' exercises where students are presented with 
content and then, depending on their responses, are directed to specific pages. The content may be text 
or multimedia. 

Watch Video: https://youtu.be/PEPGNaXZNSI 

How is it set up? 

-In a course, with the editing turned on, choose 'Lesson' from the activity chooser. 

-Give it a name and, if required, a description. 

-Expand the other sections to select the settings you want, including whether the Lesson is for practice 
or will be graded. 

-Click Save and Display and from the Edit tab, add your first page. This will usually be a Content page 
(where you add information) or a Question page (where you can select a question type.) 

-Make sure the 'Jumps' take you to the next page (if you want.) 'Jumps' direct the student to where they 
should go next. Once you have made all your pages, return and edit each Jump so it shows the correct 
page name 

-When you have saved your first page, continue adding pages from the Collapsed tab > Actions menu. 

How does it work? 

Student view 

Students click on the Lesson icon in the course to access it and, depending on the teacher's settings see 
a page of information and are prompted to choose an option from a selection of possible responses.

 

https://youtu.be/PEPGNaXZNSI


 

The Lesson may be timed, and it may display a progress bar. It may have a table of contents showing all 
pages, or the navigation may be hidden. 

 

Teacher view 

Teachers see additional tabs when they access the Lesson. They can preview the flow, edit pages, view 
reports and grade essays (if Essay questions were used.) 

 

 

The Lesson may be timed, and it may display a progress bar. It may have a table of contents showing all 
pages, or the navigation may be hidden. 

 

Teacher view 



Teachers see additional tabs when they access the Lesson. They can preview the flow, edit pages, view 
reports and grade essays (if Essay questions were used.) 

BUILDING LESSON 
This page is about how to structure a Moodle lesson once you have created it with the Lesson settings. 

Planning your lesson 

A lesson is made up of pages which may have content for the student to read or questions for them to 
answer. The questions can be created by the teacher or imported. The teacher decides the order in which 
these pages appear. 

You need to have a clear idea beforehand of what you want to do with this lesson. Is it to be a graded, 
linear learning experience? Or an ungraded, non-linear practice session? Will students be able to go back 
and revisit areas or is it just a once-only opportunity? 

Even those who are very comfortable working directly online might find it useful to note down on paper 
the direction they want their lesson pages to go in, rather than having to remember and visualize the 
navigation in their head. 

Adding content and questions to your lesson 

When you have set up your lesson with the Lesson settings, click "Save and display" and you will be 
taken to the screen in the screenshot below. 

If you click "Save and return to course" instead, then click the "update" icon next to the lesson on the 
page and click "edit" in Administration >Lesson Administration 

 

Import questions 

If you have some questions in the following formats, you can import them to use in your lesson by 
clicking the Import questions link. 



 

 

ADD A CLUSTER 
A cluster is a group of question pages which will be offered randomly to a student as they work through 
the lesson. It is best if you have made the question pages beforehand and can then decide where to 
mark the start and end of the cluster. The start is marked by a "cluster" page and the end by an "end of 
cluster" page. See Clusters for more information. 

Add a content page 

-This is a page where a teacher can provide information to move the lesson forward but without 
requiring the student to answer specific questions. 

-The student sees the page's title, some information and then one or more buttons at the bottom to 
select. 

-When the student clicks on a button, they go to the next page but their choice is not scored. 

Page title 

-The title of a content page appears to the student at the top of the page. 

-A teacher will also see the title in the collapsed edit mode when they are working on the Lesson, and 
they will also be able to choose the title (and hence this page) from the drop down "jump" lists. 

-The title in a content page is also used with the “display left menu” setting. 

Page contents 

This is where the teacher can add information for the student, making use of the Text editor and its 
multimedia features. 

Content 

-Here the teacher writes the words they want the student to click on to get to the next part of the 
lesson. 

-These words will appear to the student as a button. 

-The teacher can check the box to have the buttons appear horizontally, or uncheck it for them to 
appear centered vertically. 



 

Number of options available: 

 -How many of these you have depends on your choice in the Maximum Number of Answers setting 
in Lesson settings 

The Jump: 

• Each Description in a Content page has a Jumps menu. "Jumps" take a student from one page to 
another. 

• A "relative jump" is "next page" or "end of lesson" whereas an "absolute jump" gives the actual 
name of a page. 

• The teacher chooses from the dropdown the correct page to send the student to if they click on 
the button that will be made from this particular description. Any pages created by the teacher 
will have their titles appear in this dropdown, allowing them to be selected. 

• When a student clicks on a description button, they are sent to the page defined in the Jump 
associated with the button. 

Add a question page 

From this link you can choose from a variety of question types which will then be added as pages to your 
lesson: 

 

• (Note: These question types are not the same as the Quiz Question types and are in no way 
connected with quiz questions.) 

• The format of question pages is similar to content pages outlined in Section 2.4 above. 
• A typical question page could include: 

-Title - the name the student sees at the top of the question page. 



-Page contents - the actual question 

 

 

Answer/Response/Jump/Score as in the screenshot below 

 

Note: Short answer questions and Numeric questions only have the plain text editor in the answer field, 
as below: 

 

QUESTION TYPES 
• Multichoice 



The student is given a question and a list of answers. The answer list will be shuffled every time the 
question is view by a student. By default they choose one answer but you can check the box 
"multiple answer" to allow them to choose more than one answer. 

The file picker is available in the editor so that images and other media may be uploaded as part of 
the answers and responses. 

• Essay 

Students can write a longer answer as part of the lesson and this can be graded manually by the 
teacher. 

Students and teachers can add files such as images and can record audio and video when submitting 
or grading essays. 

Note: Non-editing teachers may also grade lesson essay questions, even though they cannot edit the 
lesson itself. 

 

• Matching 

This allows you to set up lists which must be matched against other lists, for instance, words, 
pictures, numbers etc. The student must match all correctly to receive the score. 

Numerical 

This requires a number as an answer. A number within a range may also be accepted as correct. The 
range separator to be used is the colon : For example, to accept as correct any number between 10 
and 12 (10, 11 and 12) you would type 10:12 in the answer box. Only the plain text editor is 
available in the answer box. 

• Short answer 

A student must provide a single word or short phrase answer. The teacher must anticipate the 
possible answers and enter them in the answer box, using ** wild cards if appropriate. Only the 
plain text editor is available in the answer box. 

You can include 5 or more underscores in the question text and these will be replaced for the 
student by the answer box. (This also means that fill in the blank questions may be imported from 
Blackboard and other LMS.) Including more underscores will make the answer box wider: 

 

• True/false 

The student is given a sentence and must decide if it is true or false. 

Moving your lesson forward 



Once you have added your first content or question page, you reach the next screen which displays 
your page title/type/jumps (ie where the responses take the student to) and actions you can take 
next: 

 

The Actions icons allow you to move (if you have more than one), edit, preview, delete or  

The drop down allows you to create another page of your choice: 

 

Note the different view options: 

• Collapsed view 

This gives a brief outline of the lesson structure as in the two screenshots above. 

• Expanded view 

This shows more detail as in the screenshot below: 



 

ENDING YOUR LESSON 
To bring the lesson to a close, select the "End of Lesson" option from the Jump menu on any 
relevant pages. 

The student will then see a generic message as in the next screenshot, with a direction back to the 
main course page or to view their grades: 

 

ASSIGNMENT ACTIVITY- ASSIGNMENT SETTINGS  
This page explores in more detail the settings for the Assignment activity once you have added it to 
your course. 

Note that if you want to edit an existing assignment, click the Edit link to its right and choose the 
action you wish to take, eg 'Edit settings'. 

General 



In the Description, provide instructions for students. Check the box if you want these instructions to 
display on the course page. 

In Additional files, you can add files which may be of help to the students as they do their 
assignment, such as example submissions or answer templates. 

AVAILABILITY 
Allow submissions from: 

This stops students from submitting before the shown date but it doesn't hide the assignment and 
any included instructions or materials. 

Due date: 

Submissions are still allowed after this date but will be marked as late. Disable it by unticking the 
checkbox. Assignments without a due date will appear on the dashboard with 'No Due Date' 
displayed. 

Cut-off date: 

After this date, students will not be able to submit and the submit button will disappear. 

Remind me to grade by: 

A date needs to be entered here in order for the assignment to display on the teacher's Course 
overview block and in the Calendar. It will display when at least one student has submitted. 

SUBMISSION TYPES: 
Here you can decide how you wish students to submit their work to you. 

 

Note: If Submission comments are enabled in Administration>Plugins>Activity 
modules>Assignment>Submission plugins, students will be able to add a note to their teacher on 
submitting work. If Anonymous (blind) marking is enabled, student comments display in the 
gradebook as from "Participant 01 etc" to avoid revealing identities. 

 

Online text 

Students type their responses directly in Moodle using a text editor (such as the Atto editor which 
automatically saves text at regular intervals.) 

It's possible to set a word limit on an online text assignment. Students get a warning if they try to 
exceed the word limit. Numbers are counted as words and abbreviations such as I'm or they're are 
counted as single words. 

 

 

 



File submissions 

Students can upload one or more files of any type the teacher can open. The teacher can annotate 
uploaded PDFs, docx and odt files within the browser, and on saving, the annotated file is made 
available to the student. (Check with your admin that Ghostscript and a document converter are 
enabled, if you can't annotate uploaded files.) In the screenshot below, a docx file has been 
uploaded and converted so that the teacher may use the annotation tools to comment directly on 
the student's assignment. 

 

Comments may be collapsed to make it easier to read the original text: 

 

Maximum submission size 

The maximum upload size refers to each file a student uploads. It cannot be larger than the limit in 
the Course settings. 

Accepted file types 

The teacher can specify the types of file the students may upload to the assignment. A file type 
selector appears upon clicking 'Choose' , offering a choice of different file types. (See the video File 
type selection for more information.) Leaving the field blank will allow all file types. 

If the file types have been restricted, then when students attempt to submit the assignment, they 
will see a message telling them which files are accepted: 



 

FEEDBACK TYPES 
Feedback comments 

With this enabled, markers can leave comments for each submission (which appear on the 
assignment grading screen.) 

The Atto editor now allows for recording audio and video when grading, along with the option to 
upload supporting files such as images. 

 

Annotate PDF appears if this setting is enabled by the Site administrator in the Manage assignment 
feedback plugins section of Site admin and will allow the teacher to annotate using comments, 
stamps and other features. 

 

Offline grading worksheet 

This is useful if you wish to download the grading list and edit it in a program such as MS Excel. 

 

 

 

 

 

 

 

 



 When the teacher has completed their grading offline, they can then upload the spreadsheet, 
confirm the changes and the grades and comments will be transferred over into Moodle's gradebook: 

 

 

 

 

 

 

 

 

 

 

 

Feedback files 

This allows markers to upload files with feedback when marking. These files may be the marked up 
student assignments, documents with comments, a completed marking guide, or spoken audio 
feedback. It enables the Feedback Files column in the assignment grading screen (accessed from 
'View/Grade all submissions'.) To upload feedback files, click on the green tick in the grade column on 
the grading table and then upload either with drag and drop or using the File picker. 

 

 

 

 

 

 

 

 

 

 

 



Uploading multiple feedback files is also possible: 

 

• Download the students' assignments using the "Download all submissions" link from the same 
dropdown menu; 

• Extract the folder offline and add your comments to the student's submissions.Keep the names 
the same. 

• Select the students' submissions and zip them into a new folder. Important: Don't just edit them 
inside their original folder and re-zip this; it will not work. The folder name does not matter as 
long as the feedback files have the same names as before. 

• Upload this newly zipped folder. 
• You will be presented with a confirmation screen displaying your feedback files. (If you zip files 

from a Mac,make sure to remove the folder _MACOSX) 

 

 

 

 

 

 

Comment inline 

This usefully allows you to comment directly on an 'online text' type submission. 

SUBMISSION SETTINGS 
Require students click submit button 

If this is set to 'No' students can make changes to their submission at any time. (If you want to stop them 
changing work once you are ready to grade, click 'View/Grade all submissions'; locate the student and 
From the Edit column, click the action icon and select 'Prevent submission changes.' 

If set to 'Yes', students can upload draft versions of the assignment until such time as they are ready to 
submit. Clicking the submit button tells the teacher they have finished drafting and want the work to be 
graded. They can no longer edit it and must ask the teacher to revert to draft status if they need to 
change it again. To do that, click 'View/Grade all submissions; locate the student and from the Edit 
column, click the action icon and select 'Revert the submission to draft'. 



 

 

 

 

Require that students accept the Submission statement 

An administrator can define a "Submission statement" (see below) i.e. a statement where students 
promise the work is their own and which they must agree to before submitting their work. If the 
administrator has given teachers the option of using a submission statement or not, then it will be 
available in the assignment settings screen. If the administrator has forced the statement throughout 
the site, a teacher will not have this option in the settings but a student will see the statement when 
accessing their assignment. 

Attempts reopened 

If 'require students to click submit' is enabled, then students may only submit once. You can change this 
here to 'Manually' and reopen it for students to resubmit, or you can change it to 'Automatically until 
pass', for the students to keep resubmitting until they get a pass grade. 

 

Maximum attempts 

Here you can decide how many attempts to allow if students can resubmit. If a student has to keep 
trying until they get a pass grade, you might decide to limit the attempts even though they have not yet 
passed - or they might be trying for ever! 

GROUPS SUBMISSION SETTINGS 

These settings allow students to collaborate on a single assignment, eg, working in the same online area 
or uploading , editing and reuploading an MS Powerpoint in the common assignment area. 

 

When grading, the teacher may choose to give a common grade and feedback to all students in the 
group or to give individual grades and feedback to each member. 

 

• Require group to make submission 

Students not in a group can still submit assignments unless this is forced in Site administration > Plugins 
> Assignment > Assignment settings . Moodle will then display a message You're not a member of any 
group; please contact your teacher , and the student will not be able to submit the assignment. 

• Require all group members submit 

This setting will only appear if the teacher has ticked the "Require students click submit button" earlier. 
The assignment will not be classed as "submitted" until all members of the group have made a 



contribution. When one student has submitted, the other members of the group will be able to see who 
still has to submit. 

• Grouping for student groups 

If a particular grouping is selected here, then the gradebook will display any other groups and non-
grouped students in the "default group", while naming the group(s) that are in the chosen grouping. If 
"none" is selected, then the gradebook will display the names of all groups and put any non-grouped 
students in the "default group". See this forum post on grouping for student groups for examples of how 
this might be used. 

NOTIFICATIONS 
Please note that if you are using group mode then course teachers need to be members of the group in 
order to receive submission and late submission notifications. 

 

GRADE 
See Grade points and Advanced grading methods for more information on the settings here. 

Setting a passing grade may be connected with Activity completion and Restrict access such that a 
student will not be able to access a follow up activity until they have passed this assignment. 

BLIND MARKING 
Also known as 'anonymous marking', this hides students' names when grading and instead shows 
randomly generated Participant numbers. 

With blind marking students cannot see the final grade until all of the students' names have been 
revealed. Rubrics will also be hidden from students' view until the names are revealed. To reveal student 
names after you are finished grading, look under Assignment settings > Reveal student identities. 
Feedback comments will appear whether or not student names are hidden or revealed. Note that this 
level of anonymity might not suit the privacy requirements of your organisation. See MDL-35390 for 
more details. 

Users with the capability View student identities when blind marking is enabled (by default managers 
only) can view student identities and participant numbers. 

Users with the capability View anonymous events in reports (by default managers only) can view 
student submissions to assignments with anonymous marking (in Moodle 3.9 onwards). 

MARKING (GRADING) WORKFLOW 
This lets you keep grades and feedbacks hidden until you are ready to release them to students. It is also 
useful if you want to show your progress in grading, or co-ordinate multiple markers/graders. 

 

 

 



 

The phases are: 

• Not marked (the marker has not yet started) 
• In marking (the marker has started but not yet finished) 
• Marking completed (the marker has finished but might need to go back for 

checking/corrections) 
• In review (the marking is now with the teacher in charge for quality checking) 
• Ready for release (the teacher in charge is satisfied with the marking but wait before giving 

students access to the marking) 
• Released (the student can access the grades/feedback) 

Marking allocation 

Marking allocation can be used if marking workflow is set to Yes. Teachers can then be selected to grade 
or review submitted work of specific students. 

 

WHAT IS THE ASSIGNMENT ACTIVITY? 
Assignments allow students to submit work to their teacher for grading. The work may be text typed 
online or uploaded files of any type the teacher’s device can read. Grading may be by simple 
percentages or custom scales, or more complex rubrics may be used. Students may submit as individuals 
or in groups. 

Watch Video: https://youtu.be/S4VqOEAsijk 

HOW IS IT SET UP? 
• In a course, with the editing turned on, choose 'Assignment' from the activity chooser. 
• Give it a name and, in the description explain what the students must submit. You can upload a 

help or example document from the Additional files area. 

https://youtu.be/S4VqOEAsijk


• Expand the other settings to select, for example, availability times, how you want them to 
submit and how you plan to give them feedback. (Comment inline allows you to annotate 
directly on their submitted work.) 

• If you want them to verify they are submitting their own work, or if you want to prevent them 
changing their submission once uploaded, explore the Submission settings. To have them submit 
in group, explore Group submission settings (ensuring your course has groups) 

• To use a rubric instead of a single grade scale, change the Grading method to Rubric and, once 
the assignment is saved, create or locate the rubric from the Advanced grading link in the 
Assignment administration block on the side. 

Note: Ask your administrator to check the assignment defaults if you are missing a particular setting. 

 

 

HOW DOES IT WORK? 
Student view 

• Students click the assignment link and click “Add submission” (1) 
• Depending on the assignment settings, they either have a text box into which to type their work 

or an upload area to submit their file (2) 
• They may be able to return to their work and redraft it, or they might have to click a submit 

button to send in a final version which cannot be changed. 

 



Teacher view: 

• Once students have submitted work, click on the assignment and click “Grades” 
• The exact view depends on the teacher and admin settings. See Assignment settings for more 

detail. 
• Here, the submission may be annotated (1) and/or downloaded (2); a grade entered (3) and 

individual feedback given (4). The teacher saves the changes (5) and moves to the next student 
(6) 

 

 

ACTIVITY- QUIZ 
QUIZ SETTINGS 

Creating a new quiz is a two-step process. In the first step, you create the quiz activity and set its options 
which specify the rules for interacting with the quiz. In the second step you add questions to the quiz. 

Quiz administration 
When you first set up your quiz from Add an activity or resource > Quiz, (or, if you don't have this link, 
the dropdown Add an activity>Quiz) you will get the following settings, (which can also be changed later 
in the Edit Settings link of the Quiz administration settings block) All settings may expanded by clicking 
the "Expand all" link top right. 

General 
Add a name here (which students will click on to access the quiz) and, if desired, a description of what 
they must do. 



 

Timing 
Open the quiz 

You can specify times when the quiz is accessible for people to make attempts. Before the opening time 
the quiz will be unavailable to students. They will be able to view the quiz introduction but will not be 
able to view the questions. Quizzes with start times in the future display both the open and close date 
for students. 

Close the quiz 
After the closing time, the students will not be able to start new attempts. Answers that the student 
submits after the quiz closing date will be saved but they will not be marked. 

Even after the quiz has closed students will still be able to see the quiz description and review their 
attempts. What exactly they will see depends on the settings you choose for review options (see below). 

Time limit 
By default, quizzes do not have a time limit, which allows students as much time as they need to 
complete the quiz. If you do specify a time limit, several things are done to try and ensure that quizzes 
are completed within that time: 

 

Navigation block showing quiz timer 

• A countdown timer is shown in the quiz navigation block 
• When the timer has run out, the quiz is submitted automatically with whatever answers have 

been filled in so far 
• If a student manages to cheat and goes over the allotted time, no marks are awarded for any 

answers entered after the time ran out 

When time expires: 

Note: It is always the case that if the student is actively working on the quiz when the count-down timer 
reaches zero, then their attempt will be automatically submitted at that moment. This setting only 
affects what happens if the student starts a timed attempt, then leaves the attempt, and then later time 
expires. 

There are three options as to what will happen when the time limit is up. Choose the one you need from 
the dropdown menu: 

• Open attempts are submitted automatically (This is the default) 
• There is a grace period when open attempts can be submitted, but no more questions answered 
• Attempts must be submitted before time expires, or they are not counted. 
• If you select "There is a grace period..." then you can check the box to enable the "Submission 

grace period" and specify a period of time during which learners may still submit the quiz after 
the time is up. 



Note: You can change quiz availability and duration for different groups or users in the Group or User 
override sections in quiz administration. 

 

Example of how timing is handled 

1. A student starts a quiz at noon. The quiz has a one-hour time-limit, and a 1 hour delay between 
attempts. The student gets distracted, and so actually does not submit (using the overdue 
handling) until 1:30pm. They are allowed to start their second attempt at 2. pm 

2. The quiz count-down timer submits a student's quiz attempt at the last second when time 
expires. Because the server is heavily loaded, it takes 30 seconds to process the student's 
attempt. The submission is accepted nonetheless. 

3. Same situation as above but with a 120 second delay: The submission is rejected. 
4. The delay is not because of server load but because the student found a way to cheat the timer. 

Moodle cannot know what causes a delay. The behaviour is controlled by the admin setting 
(quiz | graceperiodmin), 60 seconds by default. 

5. A student is a member of 3 groups, all of which have different override settings. Which limits 
will apply to this student? If there is any user-specific override, then that is used, and the group 
overrides for that setting are not used at all. Otherwise, if there are multiple group overrides, 
the most generous values are used (the earliest open date, the latest close date, the longest 
time limit, the most number of attempts, and the student can type any of the passwords). 

GRADE 
-Grade category 

If you have categories in your gradebook, select the one you wish the quiz to be in here. 

-Attempts allowed 

Students may be allowed to have multiple attempts at a quiz. This can help make the process of taking 
the quiz more of an educational activity rather than simply an assessment. 

Note: You can change the allowed number of attempts for different groups or users in the Group or User 
override sections of the Quiz Administration settings block. 

Grade to pass 

Here you can set a passing grade for the quiz. This may be connected with Activity completion and 
Conditional activities such that a student will not be able to access a follow up activity until they have 
passed the quiz. 

 

 



Grading method 

When multiple attempts are allowed, there are different ways you can use the grades to calculate the 
student's final grade for the quiz. 

• Highest grade - the final grade is the highest (best) grade in any attempt 
• Average grade - the final grade is the average (simple mean) grade of all attempts 
• First grade - the final grade is the grade earned on the first attempt (other attempts are ignored) 
• Last grade - the final grade is the grade earned on the most recent attempt only 

 

LAYOUT 
New page 

For longer quizzes it makes sense to stretch the quiz over several pages by limiting the number of 
questions per page. When adding questions to the quiz, page breaks will automatically be inserted 
according to the setting you choose here. However, you will also be able to move page breaks around by 
hand later on the editing page. 

Note that changing this setting has no effect on questions you have already added to the quiz. The 
setting will only apply to questions you add subsequently. To change the page breaks in an existing quiz, 
you need to go to the quiz editing screen, tick the 'Show page breaks' checkbox, then use the repaginate 
control. 

If you have many questions that use many high definition images and the server suffers performance 
issues, showing only one question per page is easier on the server that showing many (or all) questions 
in one page. 

Navigation method (available by clicking Show More) 

Choose Sequential instead of Free, if you want to force the student to progress through the questions in 
order and not go back to a previous question or skip to a later one. 

 

QUESTION BEHAVIOUR 
How questions behave 

This is the primary way to control the experience a student has as they interact with each 
question in the quiz. If you want students to get immediate feedback on their response with a 
chance to try again, if they get it wrong, then select 'Interactive with multiple tries' (and add 
some hints to your questions and specify a retry penalty if desired). If you want to replicate a 
traditional exam, select 'Deferred feedback'. In other situations, the other options can be useful. 
For a description of all the behaviours, see Question behaviours. 

Allow redo within an attempt (available by clicking "Show more") 

If using Interactive or Immediate feedback mode, enabling this setting means students can try a 
question again even if they have used up their allowed attempts. This is helpful if they wish to 



learn from the feedback given at the end of their attempts. Importantly, for students to 
continue with the same question, the question definition must contain hints. It must also have 
been added manually into the quiz, rather than randomly (see Building Quiz#Adding questions). 
Otherwise, the 'redo' will occur with a different question from the one they were working on 
previously if there are other questions available (such as when the question slot is filled by a 
random question). A student's grade for that question slot is based on the most recent question 
they have started. Note: by default students are allowed three tries to answer a question 
correctly in Interactive mode before the 'redo' option becomes available. The number of tries 
cannot be reduced but it can be increased by adding more hints to the question in the 'Multiple 
tries' section of the question's configuration page. 

Each attempt builds on the last (available by clicking "Show more") 

If multiple attempts are allowed and this setting is set to Yes, then each new attempt contains 
the results of the previous attempt. This allows the student on the new attempt to concentrate 
on just those questions that were answered incorrectly on the previous attempt. If this option is 
chosen then each attempt by a particular student uses the same questions in the same order, 
independent of randomization settings. To show a fresh quiz on every attempt, select No for this 
setting. 

 

REVIEW OPTIONS 
(These settings are collapsed by default) 

This section controls what information students will be shown when they review their past attempts at 
the quiz, and during the attempt in adaptive mode. It is a matrix with check boxes. 

 

The various pieces of information that can be controlled are: 

The attempt 

Will show how the student responded to each question. 

Whether correct 

Displays whether the students response to each question is correct or incorrect. 

Marks 

Reveals the marks awarded to the student and the grade for the quiz. 

Specific feedback 

Will show the feedback for the response to the answer as set when adding the question to the 
quiz. Each response to a question can have feedback for both correct and incorrect answers. 

 

 



General feedback 

Displays the general feedback for the whole question as set when adding the question to the 
quiz. You can use the general feedback to give students some background to what knowledge 
the question was testing. 

Right answer 

Reveals the correct answer to each question, whether the student answered correctly or not 
(See note below). 

Overall feedback 

Displays feedback for the entire quiz as set in the quiz settings (See note below). 

For each of the above items, you can determine the timeframe when the students will see them: 

 

During the attempt  

is only available when ‘How questions behave’ has been set to ‘Immediate feedback’, 
‘Immediate feedback with CBM’ and ‘Interactive with multiple tries’. If set to one of these 
options then a ‘Check’ button will appear below the answer and when clicked the student will 
submit that response and then receive immediate feedback. 

Immediately after the attempt  

means within 2 minutes of the student clicking "submit all and finish". 

Later, while the quiz is still open  

means after 2 minutes, but before the close date (if the quiz does not have a close date, this 
phase never ends). 

After the quiz is closed  

means what it says (you never get here for quizzes without a close date). 

Tip: Checking any of the boxes in the timeframe row, will reveal the test to the student. For example, to 
allow students to see their quiz immediately after taking it but not later, make sure none of the boxes in 
"Later" or "After" rows are checked. The student will be able to see their grade but not get into the quiz. 

Note: Currently, the Answers display is a bit inconsistent between different question types. For example, 
the matching question type shows students which of their responses are correct, but does not tell them 
the right answer for the ones they got wrong. The short answer and multiple choices question types do 
tell the student what the correct answer is. 

 

Users with the capability 'View hidden grades' moodle/grade:viewhidden (typically teachers and 
administrators) are not affected by these settings and will always by able to review all information about 
a student's attempt at any time. 



 

In your list of review options, you must have 'The attempt' (the first option in the lists) selected before 
you can enable the options to show 'Whether correct', 'Specific feedback', 'General feedback', and 'Right 
answer'. If you choose not to let the students review the attempt, your only options are to display 
'Marks' and 'Overall feedback'. 

 

APPEARANCE 
Show the user's picture 

It is now possible, when displaying the user's profile picture for proctoring purposes, to choose 
whether a large image or thumbnail will be displayed. 

Decimal places in grades 

This option determines how many digits will be shown after the decimal separator (see 
langconfig ) when the grade is displayed. A setting of 0 for example means that the grades are 
displayed as integers. This setting is only used for the display of grades, not for the display or 
marking of answers. 

Decimal places in question grades 

By default this is an advanced setting. You need to click Show more ... to reveal it. Lets you have 
a different display of grades for each question compared to the quiz total. For example you may 
which to see the total as a whole number, but still show fractional grades for each question. 

Show blocks during quiz attempts 

Also an advanced setting by default. You can control whether blocks are shown on the page 
during quiz attempts. 

Overall feedback 

Overall feedback is shown to a student after they have completed an attempt at the quiz. The text that 
is shown can depend on the grade the student got. Click "Show editing tools" to display the rich text 
editor, and drag the bottom right of the text box out to expand it. 

 

 

 

 



For example, if you entered: 

 

Grade boundary: 100% 

Feedback: "Well done" 

Grade boundary: 40% 

Feedback: "Please study this week's work again" 

Grade boundary: 0% 

Then students who score between 100% and 40% will see the "Well done" message, and those who 
score between 39.99% and 0% will see "Please study this week's work again". That is, the grade 
boundaries define ranges of grades, and each feedback string is displayed to scores within the 
appropriate range. 

 

Grade boundaries can be specified either as a percentage, for example "31.41%", or as a number, for 
example "7". If your quiz is out of 10 marks, a grade boundary of 7 means 7/10 or better. 

 

Note that the maximum and minimum grade boundaries (100% and 0%) are set automatically. 

 

You can set as many or as few grade boundaries as you wish. The form allows you up to 5 ranges at first, 
but you can add more by clicking the "Add 3 fields to form" button underneath. 

 

If you're getting confusing error messages about a boundary being out of sequence (when it's obviously 
*in* sequence), or "boundaries must be between 0% and 100%" (and they are) -- check that the 
Maximum Grade for this quiz is set to something greater than zero. 

 

If you want to reduce the number of boundaries and feedbacks, you will need to remove all feedbacks 
and boundaries and then add the reduced amount. 

 

Quiz completion 

The following automatic activity completion conditions apply to the quiz: 

 

Require view - the student clicks on the quiz to view it 

Require grade - the student obtains a grade 



Require a passing grade - a 'Grade to pass' is specified for the quiz in the gradebook. 

All available attempts completed - a certain number of attempts were allowed on the quiz and the 
student has completed them all. 

 

HOW A MOODLE QUIZ WORKS 
Once a quiz has been added to the course and the Quiz settings established, the teacher can start to 
build the quiz. The teacher can access the quiz to edit the questions by clicking directly on the Quiz 
name on the course home page or by clicking "Edit quiz" in Administration>Quiz administration. (You 
can also make questions in the Question bank without first creating a quiz. These questions may then be 
used later.) 

 

Adding questions 
Once you have accessed the quiz editing screen as above, you can add questions from a number of 
locations: 

 

1. Click the 'Add' link as in the screenshot below. (Note that in the US, the term 'marks' is replaced 
by 'points'.) 

2. When it opens up, choose either to add a new question, to select a question from the question 
bank or to add a random question. 



 

 

Creating a new question 
1. To make a brand new question, click 'Add' and then '+ a new question'. 

 

2. From the next screen, choose the question type you want to add and click "Next" ('When you 
click on a question type on the left, helpful information appears on the right. ) 

 



 

3. Fill in the question form, making sure to give a grade to the correct answer. 

 

4. Click "Save changes". 

 

Note: If you have a very complex question, and you want to check it as you go along, you can preview it 
and then click "Save changes and continue editing". 

 

When a question has been created, an icon and words display its type (eg multiple choice). It can be 
modified by clicking the edit icon (eg editicon.png) and previewed by clicking the magnifiying glass icon. 

 

As well as deleting individual questions with the delete (bin/trash can) icon, it is possible to delete more 
than one question by pressing the 'Select multiple items' button and choosing the questions to be 
removed: 

 

Adding responses and feedback 
5. When you add responses and feedback, remember you can expand the toolbar to show more 
buttons. 

 

6. You can continue adding questions this way, clicking 'Add' and '+ a new question' each time. 

 

Choosing a pre-made question 
If other teachers in the course have made questions, or if a teacher made questions in an earlier quiz, 
these can be added to the current quiz by clicking 'Add' and '+ from question bank' . 

Click the + sign next to one question you want to add it (1 in screenshot below) 

If you have several questions, or you want to add all the questions, tick the box of each question or the 
top box (2 in screenshot below) and then click 'Add selected questions to the quiz' (3 in the screenshot 
below). 



To sort the questions, click the column headings. The default sort order (T) is short for question type. (2 
in the screenshot below) 

To ensure all previously made questions are available, make sure to tick the boxes "also show questions 
from sub-categories/old questions 

 

Note: It is also possible to import pre-made questions into your quiz, from Quiz administration>Question 
bank>Import. See Import questions for more information. Sample questions are available from the 
Moodle.net content database. 

 

Adding a random question 
As long as you have questions in the question bank, you can add random questions to your quiz by 
clicking 'Add' and then '+ a random question'. This might be useful if you have students in a class taking 
a quiz at the same time, because they are unlikely to get the same questions at the same time. The same 
question will never appear twice in a quiz. If you include several random questions then different 
questions will always be chosen for each of them. If you mix random questions with non-random 
questions then the random questions will be chosen so that they do not duplicate one of the non-
random questions. This does imply that you need to provide enough questions in the category from 
which the random questions are chosen, otherwise the student will be shown a friendly error message. 
The more questions you provide the more likely it will be that students get different questions on each 
attempt. When a quiz with random questions is retaken, the random questions will be different from 
the ones in previous attempts. For a discussion on the behaviour of random questions, see MDL-6340 

 

The grade for the randomly chosen question will be rescaled so that the maximum grade is what you 
have chosen as the grade for the random question. 



 

You can add one or more random questions by choosing the number and category in the question bank. 
Note the die icon to highlight random question selection. Random questions may be filtered by tag and 
New in 3.5 a list of random questions will be displayed when filtered. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: If you add random questions and your category of questions contains more than 10 
different questions, when you look at the quiz statistics report related to position 1, it will not show 
them all on the front page of the report, just a summary, and then you have to click a link to drill down 



into the details (the report MDL-48092 is about the fact that working out which link to click is too 
difficult). 

 

 

Quiz question tags 
Questions may be tagged as they are created (as well as from the Question bank). Questions 

may be searched and filtered by tag in the Question bank and when adding random questions, as above. 

 

Question categories 
Questions can be stored and retrieved from categories in the Question bank. When you make a 

new question it defaults to the category with the course name. So if you make a quiz in the Senior 
Physics course, questions will automatically be added to "Default for Senior Physics". You can opt to 
have your quiz questions in a category of their own ("Quizname") or to add a subcategory. 

 

To add a subcategory, go to Administration>Quiz administration>Question bank>Categories For 
more information on question contexts and categories, see Question bank 

 

Users will have access to different categories according to their permissions. For example, a 
regular teacher might only have access to question categories in his own Physics course whereas his 
Faculty Head of Science with permissions in all science courses might have access to question categories 
in Biology and Chemistry as well. 

 

Quiz layout 
You can choose in the Layout section of the quiz settings whether to have a new page for every 

question or after a certain number of questions. 

You can add a page break between questions by clicking the arrow icon (where the arrows are 
pointing away from each other) (1 in the screenshot below) A new page will be created. (2 in the 
screenshot below) 

You can remove pages by clicking the arrow icon (where the arrows are pointing towards each 
other). (3 in the screenshot below) 



 

You can also change the layout of the whole quiz by clicking the 'Repaginate' button: 

 

 

 



Section headings 
Section headings may be added to each new page. 

For the first page, click the 'pencil' icon at the top (1) and add your heading (2): 

 

For other pages, click the 'Add' link (1) and choose 'a new section heading' (2), and then add 
your heading as for Page 1: 

 



The section headings are displayed in the Quiz navigation block: 

 

Randomising the order questions appear 
The order in which questions appear to the student may be randomised or 'shuffled' by ticking 

the 'Shuffle' box at the top of the screen: 

 

Where questions are in different sections (see Section headings above), each section has its own 
'Shuffle' box to tick. This means that you can mix up questions on one section, but in another section, 
where their order is important, you can keep them in the order you need them to display: 

 

 

 

 



Making questions conditional upon other questions 
If using the Interactive with multiple tries or Immediate Feedback behaviour and with the 

navigation method set to 'Free', it is possible to make the display of a question dependent on a previous 
question being answered first. 

The question editing page will display padlock icons to the right of each question: 

 

 

If you want to make a question, for example Q2, conditional upon answering Q1, then click the 
padlock just above Q2: 

 

 

 

When a student accesses the quiz, they will see a message that Q2 is not available until they give 
a response to Q1: 



 

In the Quiz navigation block, Q2 will be greyed out: 

 

In the following example, note that, Q1 follows a description, and a description 'questions' cannot be 
finished. Therefore, Q1 cannot depend on the previous question. Similarly, Q4 follows an Essay 
question. The Essay cannot be finished during the attempt, so the following question cannot depend on 
it. Note the lack of padlocks in the following screenshot because of the description and Essay question: 

 

Assigning points to questions 

Administration > Quiz administration > Edit quiz > Editing quiz 

 

You can set how many points each question is worth by changing the number in the box to the right of 
each question and you can change the maximum grade by changing the number in the box top right at 
the top of the quiz. The default is one point per question and 100.00 maximum grade. 

 

 



 

 

 

 

The quiz module will do any maths, so for example, a 2 point question will be worth 2 times more when 
the Quiz module determines how many point out of 10 to award the student. 

Previewing the quiz 

• You can preview individual questions by clicking the magnifying glass icon. 

• You can preview the whole quiz by clicking the "Preview" link in Administration>Quiz 
administration>Preview 

• The quiz works like a real quiz so you can see your grades and any feedback for correct/incorrect 

answers just as a student would see them. 

NOTE: To get a more accurate view of how a student would view your quiz, it is advised to log in with a 
"dummy" student account created by the admin for testing activities. This is more reliable than the 
'switch role to student' feature. 

 

 

 

After quiz has been attempted 
If one or more students have taken the quiz, you will see a list of all the questions in the quiz 

and a notice saying that you cannot add or remove questions. 

You can change the order of questions, regrade them, preview an individual question and click 
on an question edit link that will allow you to directly edit the question stored in the question bank. 



 

Note: You can delete all quiz attempts by students and then edit the quiz as if no students had 
attempted it. To do this,click the quiz name and then the Results link in the Administration block. This 
will present a list of students and their scores. Click "Select all" and then "Delete selected attempts". 

Dealing with faulty questions 

There are several ways to deal with "bad" questions in a quiz: 

• Change the grade for the bad question to 0 in the quiz. 
• Edit the question, changing what you will accept as a correct answer, then regrading the 

exam. Remember when changing a question that the next time it is used it will be as it 
was in the last edit. Also, regrading will only affect one quiz at a time. 

• You can edit the question to explain the situation to the student and then you can set 
the grade for the question to zero. After you make such changes you should regrade the 
quiz by clicking on the Results tab and then the Regrade tab. This will change the grade 
for all students who have taken the quiz so far. Remember, if the question is used by 
another quiz, your "explanation" will appear as part of that quiz. 

• You can change the grade for the bad question and then move or delete the question 
from your question category. The question will still appear on the quiz. Some places do 
not like to delete any question, but will move them to a "dead" or "bad" question 
category. 

• When you discover a bad question in your quiz, it may affect the question bank. 
Remember that a final might be made up of a certain number of random questions 
drawn from different question categories, the same categories used in a smaller subject 
quiz. It can be very important do something about bad or invalid questions in a question 
category when the categories are use in other places. 

 

About H5P 
H5P is an abbreviation for HTML5 Package. It enables educators to create content such as interactive 
videos, quizzes and presentations. H5P content can be created in the Content bank (new in 3.9), or on 
h5p.com, and added to your course as an H5P activity (new in 3.9) or embedded into any other activity 
or resource. 

Watch Video: https://youtu.be/p7ihJZgZQ4M and https://youtu.be/ctRh1vtVXFA 

 

Creating and editing H5P content 
To create and edit H5P content, 

1. Go to the Content bank, accessible when in a course from the Navigation drawer (Boost theme) 
or from Site pages in the Navigation block (Classic theme). 

2. Click the Add button and select the activity you want. 

https://youtu.be/p7ihJZgZQ4M
https://youtu.be/ctRh1vtVXFA


 

Embedding H5P: 
H5P button in the Atto editor 

H5P content created in the Content bank or on h5p.com may be embedded into activities and resources 
such as a Lesson or a Book, by clicking the H5P button in the Atto editor. 

 

The URL can be linked to or else the file can be uploaded. Note that if you enter a URL, the Display H5P 
filter should be enabled and the URL should be listed as an allowed source in Site admin / Plugins / 
Filters / Display H5P. You can also use the Content Bank repository to pick the existing content. 
Remember that if you add the content as an alias, any content edition will update this instance; but if 
you add it as a copy changes won't be applied.  

 

Manage H5P content types 
In order for teachers to upload and display existing H5P files in their courses, the appropriate H5P 
content types and libraries must be available on the site. 

A scheduled task Download available H5P content types from h5p.org should do this automatically (but 
check if it is enabled and has already run after first upgrading your site). 

If it is not possible to use this scheduled task, then the Site administration page 'Manage H5P content 
types' allows you to upload necessary files. 

Note also that without the scheduled task or the relevant files being uploaded, course teachers will 
receive an error message when trying to upload H5P content. 

View: https://h5p.org/content-types-and-applications 

 

 

 

 

 

 

 

 

 

 

https://h5p.org/content-types-and-applications


STUDENT ENROLLMENT  
Enrolled users 

All course participants are enrolled in the course and assigned an appropriate role. (This is different 
from versions of Moodle prior to 2.0, in which only users with a specified role such as student were 
enrolled in a course.) 

 

Enrolled users: 
• Can be assigned to groups 
• Have grades 
• Can submit assignments 
• Are visible in the list of participants 
• Can subscribe to forums 
• Can participate in choices 
• Only enrolled users are true participants in course. 

 

 

 

The enrolled users page Settings > Course administration > Users > Enrolled users lists all users enrolled 
in the course, together with their last access time, roles, groups and enrolment methods. 

 

Roles 
To assign an enrolled user a role, click the 'Assign roles' icon (a plus sign) in the roles column then select 
the desired role. 

To remove a role assignment, click the delete icon (a cross) next to the role name. 

 

Groups 
To add a user to a group (requires at least one group to have been created previously), click the 'Add to 
group' icon (a plus sign) in the groups column, select the desired group then click the 'Save changes' 
button. 

 



Enrolling users 
To enroll users in the course (requires Manual enrolment to be enabled in Enrolment methods): 

 

Method 1 

 

1. Go to Settings > Course administration > Users > Enrolled users 
2. Click the 'Enroll users' button at the top right or bottom left of the page 
3. Use the 'Assign roles' dropdown if you wish to change the role 
4. Select enrolment options as appropriate 
5. Browse or search for the user 
6. Click the Enroll button opposite the user. The user will indent in the list and the enrol button will 

disappear, indicating that the user is enrolled. 
7. When you have finished, click the 'Finish enrolling users' button (or simply close the enrol users 

box) 

The user will then appear in the list of enrolled users. 

Note: The enrolment option 'Recover user's old grades if possible' is not ticked by default and is easy to 
miss. An admin can make it so that the checkbox is ticked for all courses on the site by enabling the 
setting 'Recover grades default' in Settings > Site administration > Grades > General settings. 

 

Method 2 

1. Go to Settings > Course administration > Users > Enrolment methods 
2. Click the 'Enroll users' icon in the edit column opposite manual enrolment 
3. Select users from the not enrolled users list, using Ctrl + click to select multiple users 
4. Click the add button to add the users to the enrolled users list 

 

 

 

 



Extending enrolment 

It is possible to extend the enrolments of students enrolled manually into a course via Course 
adminstration>Users>Enrolled users 

 

1. Change the Enrolment methods dropdown to "Manual enrolments" 
2. Select the users whose enrolment you wish to extend by ticking the box by their name 
3. From the "Selected users" dropdown box, choose "Edit selected user enrolments" and click "Go" 
4. This takes you to a screen where you can alter the start/end time of their enrolment 

 

 

 

HOW TO CONVERT PRESENTATION SLIDES TO IMAGES- PNG FORMAT 
To save PowerPoint slides as pictures: 

 

1. Select the slide you want to save as an image. If you want to convert all the slides to images, 
select any slide. 

2. Select File > Save As. In PowerPoint for Mac, select File > Export. 
3. Choose the location where you want to save the file and enter a name for the image file. 
4. Select the Save as type down arrow to display a list of file formats. By default, PowerPoint 

Presentation (*.pptx) appears in the text box. On Mac, use the menu next to File Format. 
5. Select the image format you wish to save your presentation. Choose either GIF, JPEG, PNG, TIFF, 

BMP, or WMF. 
6. Select Save. In PowerPoint for Mac, choose either Save Every Slide or Save Current Slide Only, 

then select Export. 
7. Choose whether you want to export All Slides or Just This One. 
8. The slide is saved in the selected file format. 

 

If you convert more than one PowerPoint slide to separate image files, a new folder is created in the 
destination folder. This new folder uses the same name as the presentation. If you haven't saved the 
PowerPoint file, your exported slide images are saved in a folder with a default name, for example 
Presentation1. 
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